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UPDATE

Word Processing
In Inserting a Non-breaking Hyphen

Sharon Parq Associates has provided

another word processing tip on a little

covered subject. Simple tips like this

can make your word processing task

easier.

up the startup programs have been the

tradtional ways to speed up your com-

puter. While these two methods are well

accepted and proven to speed up the

boot process, a new concept in utilities

was recently released that goes an extra

step in controlling the boot process. Read

all about it.

Hardware
In Security - Recycling & Inheriting

PCs the author highlights some ways to

stay secure whether you’re inheriting a

used system or passing your old PC to

another user.

In Should You  Defrag A Flash Drive?

the author points out that a flash drive

does not have the same physical features

as a hard drive and should never be

defragged since it may be damaged.

In Lurking Dangers of Larger Hard

Drives the author points out that with

large drives you tend to keep files that

you used to discard. Antimalware pro-

grams take longer to run. Large files are

more readily fragmented and backups

need more storage capacity. You may

have to modify the way you operate to

avoid some of these negatives.

In Troubleshoot Your Digital Camera

the author notes that if you have prob-

lems you should  doublecheck the trans-

fer procedures for your camera because

all cameras don't use the same techniques.

It may be simpler to use a card reader to

transfer photos.

In Who Invented the ‘‘CD’’ the author

gives us a brief history of James T. Russell

the man who developed the CD-Rom

among other inventions throughout his

life.

In Streamline Office 2007 with

Screen Tips and Live Preview the au-

thor states: ‘‘One of Microsoft’s stated

objectives for the changes inOffice 2007

was to make users able to complete

work tasks more quickly. Another goal

was to help them create more profes-

sional-looking products. To meet these

objectives, the ScreenTips feature was

enhanced and the Live Preview feature

was introduced. Understanding and

using both of these tools can result in

user efficiency and improved quality of

output from Word, Excel, and

PowerPoint 2007. ’’

Spreadsheet
In Indenting Cell Contents Sharon

Parq Associates shows another fea-

ture of Microsoft's Spreadsheet pro-

gram EXCEL.

Communications
In Making Wireless Internet Faster

author Vinnie LaBash talks about the

good and bad features of wireless net-

works and how you can overcome some

of the weaknesses.

In Hacking 101 the author talks about

how hackers get at your computer, and

lists some of the tools they use. Know-

ing about these may enable to better

protect yourself by selecting software

that detects and protects against these

threats.

General Interest
In Copy Changed Files the author makes

you aware of a free program to copy only

those files that have been changed. Worth a

look.

Operating System
In Soluto Anti-Frustration Software  Im-

proves Boot Time Ira Whilsker notes that

defragging the hard drive and cleaning
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WORD PROCESSING NOTES & TIPS

Inserting a Non-Breaking Hyphen
by Sharon Parq Associates, Inc.

When Microsoft Word calculates line length and wraps text

to the next line, it tries to wrap (or break) the line at a space or

a hyphen--a dash. Sometimes, however, you may not want

Word to break a line at a dash. For instance, dashes are used

in telephone numbers, and you might not want a line to break

in the middle of a telephone number.

The answer is to use non-breaking hyphens instead of

regular dashes when you don’t want Word to break a line at

the hyphen. To do this, hold down the CTRL and SHIFT keys

as you type the dash (this is the same as typing CTRL and an

underscore). Word will then not break the line at that point.

You can also insert a non-breaking hyphen by following

these steps:

1. Choose Symbol from the Insert menu or, in Word 2007,

display the Insert tab of the ribbon, click Symbol in the

Symbols group, and finally click More Symbols. This dis

plays the Insert Symbol dialog box.

2. Click on the Special Characters tab.

The Special Characters tab of the Symbol dialog box.

3. Highlight the Nonbreaking Hyphen character.

4. Click on Insert.

5. Close the dialog box by clicking on Cancel.

Copyright ¬ 2010 by Sharon Parq Associates, Inc. Re-

printed by permission. Thousands of free Microsoft Word tips

can be found online at http://word.tips.net.

Streamline Office 2007 with Screen Tips
and Live Preview

by Nancy DeMarte, <ndemarte@verizon.net>

Sarasota Personal Computer Users Group, Inc.

One of Microsoft’s stated objectives for the changes inOffice

2007 was to make users able to complete work tasks more

quickly. Another goal was to help them create more profes-

sional-looking products. To meet these objectives, the

ScreenTips feature was enhanced and the Live Preview fea-

ture was introduced. Understanding and using both of these

tools can result in user efficiency and improved quality of

output from Word, Excel, and PowerPoint 2007.

Office 2003 and most previous versions included ScreenTips,

which showed the name of a command button when you

hovered the mouse pointer over it. Word 2007 offers not only

standard ScreenTips (the name of a button), but also en-

hanced tips, such as a definition of the command, the key-

stroke combination to access it, and more information, such

as when and how to use it. This enhancement provides a

helpful interactive, on-the-job glossary of commands, saving

the user the inconvenience of looking up the function of an

unfamiliar button in the Help menu.

Take, for example, the Format Painter button, found in the

Clipboard group on the Home tab in Word 2007. Merely

moving the mouse pointer over this button reveals the follow-

ing enhanced ScreenTip: Format Painter (Ctrl+Shift+C) - Copy

formatting from one place and apply it to another. Double-click

this button to apply the same formatting to multiple places in

the document. Or consider the Watermark command, a new

tool of Word 2007 found in the Page Background group on the

Page Layout tab. When the mouse pointer is hovered over this

command, you see a thumbnail of a page with a watermark,

along with this text: Insert ghosted text behind the content on

the page. This is often used to indicate that a document is to

be treated specially, such as Confidential or Urgent. This tight

annotation gives not only the name of the command, but a

definition and examples of its use.

Office 2007 users have the option to view just the standard

ScreenTips or both the standard and enhanced tips. To make

your choice in Word, click the round Office button in the top

left of the Word window - Word Options - Popular - Top

Options for Working with Word. Here select Show (or don’t

show) feature descriptions in ScreenTips or turn off the

ScreenTips altogether.

Another time saver as well as a tool for making documents

or presentations look professional is a new feature called Live

Preview, which lets you preview changes instantly before

committing to them. Let’s say you have drafted a document

and are considering changing the font of a certain section.

First select (highlight) a group of text. Then click the Font

arrow next to the current font name on the Home tab to reveal



       TOGGLE  August  2010 Page 3

the menu of available fonts. Position the mouse pointer over

any font name on the list, and watch the selected group of text

change to this font immediately so you can see what it would

look like if you clicked the mouse button. Once you find the

font you like, make your choice by clicking its name.

Live Preview works in Word, Excel, and PowerPoint with

buttons where there are options, such as font styles, colors,

and sizes; as well as bulleting and numbering styles. The new

Word feature, Quick Styles, which are preset headings and

other document parts, coordinated by color and font style,

shows the power of Live Preview. You can see how a docu-

ment would look in a new style by merely positioning your

cursor anywhere inside a paragraph (no highlighting needed)

and moving your mouse pointer over one of the style sets on

the Home tab. If you like the look, click the style. If you wish

to cancel, press the ESC (Escape) key. In Excel, Live Preview

works with fonts, including sizes and colors, as well as fill

colors, cell styles, and Format as Table styles. In PowerPoint,

use Live Preview on the font options in Word plus themes and

transitions.

If you find you don’t like the instantaneous changes that

appear when Live Preview is in effect, you can turn off this

feature. Click the Office button - Word Options - Popular, and

remove the checkmark from the Enable Live Preview box.

Enhanced ScreenTips gives you an easy way to learn or

remind yourself of commands. Live Preview helps you quickly

create products like a professional page designer. These

upgrades in Office 2007 help make it a valuable suite of

programs, but only if you use them.

Copyright 2010. This article is from the July 2010 issue of

the Sarasota PC Monitor, the official monthly publication of

the Sarasota Personal Computer Users Group, Inc., P.O. Box

15889, Sarasota, FL 34277-1889. Permission to reprint is

granted only to other non-profit computer user groups,

provided proper credit is given to the author and our

publication.

SPREADSHEET NOTES & TIPS

Indenting Cell Contents
by Sharon Parq Associates, Inc.

Microsoft Excel allows you to format the contents of a cell

in a myriad of ways. One of the formatting options you can

apply is to indent the contents of a cell by a certain amount.

This is similar to indenting done in a word processor, such as

Microsoft Word, except that the indenting is specified in a

number of characters, not in a linear distance such as inches

or points.

To set the indent to be used in a cell, follow these steps:

1. Select the cells you want to format.

2. Display the Format Cells dialog box. (In Excel 2007 display

the Home tab of the ribbon and click the small icon at the

lower-right corner of the Number group. In older versions

of Excel choose Cells from the Format menu.)

3. Make sure the Alignment tab is selected.

The Alignment tab of the Format Cells dialog box.

4. In the Horizontal drop-down list, choose Left (Indent). If

you are using Excel 2002 or a later version, you can also

choose Right (Indent).

5. Using the Indent control, specify the number of characters

by which the cell contents should be indented from either

the left or right side of the cell. You can pick any whole

number between 0 and 15.

6. Click on OK.

Copyright ¬ 2010 by Sharon Parq Associates, Inc. Re-

printed by permission. Thousands of free Microsoft Excel tips

can be found online at http://excel.tips.net.
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COMMUNICATIONS NOTES & TIPS

Making Wireless Internet Faster
by Vinny La Bash, <vlabash@comcast.net> Sarasota

Personal Computer Users Group, Inc.

A wireless network works on the same principle as any other

communications network. It is a collection of various devices

connected to each other in a way that allows data to flow

unimpeded, and unchanged from one device to another. The

main difference is that in a wireless network, there is no

physical connection between or among the different devices.

The main advantage of a wireless network is portability within

the range of the network. The main drawback is that the quality

of the communications signal can vary greatly within the

range of the network sometimes resulting in disruption of

communications services.

Some Basics: For simplicity, our discussion will be re-

stricted to internet based home wireless networks. There is no

need to delve into the complications of corporate, military or

other kinds of complex communications networks. The basic

equipment required to set up a home network is:

-  An internet service provider (ISP) that provides access to

the internet.

- A modem that provides access to the ISP.

- A router that broadcasts the wireless signal.

- Devices such as laptops, desktops and printers that receive

the signal through a network interface card (NIC).

There are several standards for wireless networks devel-

oped by the group that regulates the industry’s standards,

The Institute of Electrical and Electronics Engineers (IEEE).

Amongst these standards are those that set criteria for data

transmission speeds.  Don’t buy, or accept from your ISP, a

wireless router before determining how fast it transmits data.

Manufacturers are required to display the standard in their

product specifications. Either get the information from your

ISP or look for these specifications on the box.

Regardless of your experience level with wireless networks,

don’t consider anything less than standard 802.11g. Most g

devices are not only inexpensive, but far superior to the older

802.11 a or b wireless routers. Besides being competitively

priced, g routers have far superior network security. 802.11b

routers offer only Wired Equivalent Privacy security (WEP).

802.11g routers have Wi-Fi Protected Access (WPA), which

overcomes the weaknesses of WEP.

How large are the files you upload and download from the

internet? If you normally do not move large files in either

direction standard 802.11g will do fine, and it has the additional

advantage of being cheap. If you are moving large files, then

go for a Faster, Super G router.

The most common problem with home wireless networks is

either loss of signal or a signal that is too weak to allow reliable

connections. One way to solve this is by boosting the signal.

If you’re willing to spend a few bucks you can plug a Hawking

HAI15SC Hi-Gain Wireless Corner Antenna into your router

and enhance signal strength from the standard 2dBi to up to

15dBi. Before you run out and buy this enhancement be sure

that your router has a removable antenna. Check your router’s

manual or contact the manufacturer for information.

If your router doesn’t have a removable antenna there is an

alternate, but higher priced method to increase signal strength.

A Wireless-G Range Expander also does the job. It has a great

advantage that it does not have to be physically connected

to any part of your network. All that’s necessary is that it be

in range of the router. The device works similar to a repeater

in cellular networks. It performs well in multi-story homes,

back yards, lanais, and other outdoor venues.

The Expander is compatible with the Linksys Routers. It also

works with Wireless-G and Wireless-B clients.

Everyone who uses or who is contemplating using a wire-

less network is rightly concerned with performance. But don’t

let performance issues blind you to proper security. The

fastest wireless network on the planet won’t do you much

good if a hacker is robbing you at the speed of light.

Wireless networks have become very common for individu-

als and organizations. A new PC is very likely to have wireless

access pre-installed. Hackers have become adept at breaking

into wireless networks, and you should not overlook this

danger while enhancing performance.

At a minimum you should change any default passwords

and select a method that will securely encrypt your data

should your protection methods be compromised. Your local

PC user group is a great resource for giving you this kind of

assistance. Don’t overlook this abundant source of expertise.

Copyright 2010. This article is from the July 2010 issue of

the Sarasota PC Monitor, the official monthly publication of

the Sarasota Personal Computer Users Group, Inc., P.O. Box

15889, Sarasota, FL 34277-1889. Permission to reprint is

granted only to other non-profit computer user groups,

provided proper credit is given to the author and our

publication.
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Hacking 101
By Marjie Tucker, Editor, Macon Computer User Group,

North Carolina

found in the Newsletter of the Hartford User Group

Exchange May, 2010

www.mcug.org       mcug (at) dnet.net

This article has been obtained from APCUG with the

author’s permission for publication by APCUG member

groups; all other uses require the permission of the author

(see e-mail address above).

We are being bombarded with warnings about securing our

data and the entry to our computers. Do you ever wonder what

the big fuss is all about? How can a hacker possibly get into

your data? And, what would he be looking for? Let’s spend

some time answering those questions.

How Does A Hacker Get In To Your Computer?

When you give your computer access to the Internet, you

need an IP (Internet Protocol) address. The IP addresses that

we are currently using have 4 octets with periods between

them. They will be something like 192.168.100.1. When you

access the Internet, that address is read by the router, modem,

whatever that links you to your Internet Service Provider.

Then it is read by the routers that route all the data through

the Internet. This address makes it possible for you to send

data, such as e-mail or requests for web pages. And, in turn,

that same address is used to direct incoming e-mail and web

pages into your computer. There are several websites and

programs available that will translate these IP addresses into

the name of the company that purchased them. In many cases,

like our residential usages, the company name will be the ISP.

For commercial use, it will be the name of the company that

rents the block of IP addresses. Hackers use this IP address

information to find their targets much like we use a physical

address to find a house or office.

Once a hacker finds out your IP address it’s relatively simple

to send your computer a Trojan horse program, spyware, or

a virus that will open a port that you usually don’t use. Once

that port has been opened, he can freely enter into your

operating system and browse around just like he was there in

person. He would look for programs that store valuable data

like social security numbers and credit card account numbers.

(Do you have that information entered into your Quicken or

Money program?)

He would look through your My Documents folder for

password lists and search your Internet Explorer favorites for

financial sites where you saved the username and password.

And, before he leaves he usually plants another Trojan horse

that will give him the ability to take control of your computer

in the future.

Commercial Websites

The most common way to hack into a company’s website

through the Internet is by using a Denial of Service attack.

These DoS attacks use multiple computers to overload a

website with bogus requests for information.

The hacker usually creates a Trojan horse program that he

sends into the computers of unsuspecting people (remember

that program that was left behind when your computer was

invaded above?) The message that he creates usually con-

tains a header saying that it comes from an IP address that

doesn’t exist.

When he is ready to attack, he calls up all the computers that

he infected with his Trojan horse and tells them to contact a

specific IP address. Those computers follow his instructions

and send his preprogrammed message to that website. Servers

that control websites always check to verify that IP addresses

requesting information or webpage downloads are legitimate

addresses. When a server is hit by a bombardment of these

false address requests, it tries to track down every one of the

fake addresses. Before long the server becomes overwhelmed

by the fruitless process and crashes. When it crashes, the

website will vanish and the hacker will be given access to a

prompt for the server. He can then use Linux or DOS com-

mands to request and view information on that server other

servers.

How About Wireless?

Let’s put this hacker into an airport where hundreds of

people are sharing a wireless network. It’s like leaving a child

alone in a candy store. In this case the airport’s wireless

system usually provides the IP addresses through DHCP and

he can easily look at the list of addresses that have been

supplied. He can test each of the addresses for available ports

and it’s quick work to access the most vulnerable. The same

principles apply in hotels and restaurants that provide wire-

less Internet access. If you have a wireless network in your

home, our hacker can drive down your street using a laptop

or PDA to search for wireless networks. This process is called

Wardriving. If he finds one that has not been secured at all,

he doesn’t even have a challenge. If you have added a

password, he simply has to crack the password.

What Tools Do They Use?

It’s very easy for a potential hacker to find the tools of his

trade. There are many websites that offer program tools and

tutorials for using them. Here are some of the popular:

Anonymizers and Remailers - Anonymizers are online ser

vices that eliminate the trail of information that is left behind.

These sites use anonymous proxies that a hacker can use

to access computers and servers without leaving his IP

address on any log. Remailers strip the header off a message

and replace it with a meaningless header that can’t be traced.
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Command.com - When this command is typed into a server it

will basically give you administrative rights. You can then

see all the folders and files. It’s also very easy for the hacker

to create a new administrative account that he can re-use in

the future.

Password Crackers - These programs try random passwords

at lightening speeds. They are usually very successful.

Key Loggers - Hackers frequently install these on computers,

especially public PCs. The programs actually record every

stroke that you make. Hence, when you type in a username

and password, it has been captured.

Port Knocking - This is a method of externally opening ports

on a firewall by mimicking the process you normally use to

add a port to your firewall.

Wireshark - This popular program captures and analyzes the

data on a network. It’s used by hackers to find information

they want and it’s also used by network administrators to

manage networks.

Aircrack - This program is used to crack wireless WEP and

WPA passwords.

Metasploit Framework - This is a tool that can be used by

hackers to search the Internet for sites that have dubious

code. These are the sites that are the easiest to

hack - especially when this program does the searching for

you.

Networks identifying the types of data and the internal

addresses of this data. It’s a valuable tool for administrators,

but can save a great deal of time for a hacker.

NMAP - This is a port scanner. Since a hacker knows that he

needs to use a port to access your computer or network, he

can use this program to see which ports you have open.

NetStumbler - This program finds any wireless networks that

are in range.

Wardrivers drive through residential neighborhoods using

Netstumbler to search for available wireless networks.

Kismet - This program takes Netstumbler one step further. It

searches for wireless netwroks that are not broadcasting

their SSID.

NSLookup - If you type a domain name into this program, it

will give you the company’s IP address/

Traceroute - This is a very valuable troubleshooting tool for

technicians. It will trace a oacket on its route throught the

Internet. It shows every IP address it visits along the way.

Snort - This is an open-source intrusion detection system. It

shows traffic analysis and packet logging on networks.

TCPdump - This is themost widely used network sniffer/

analyzer for UNIX networks.

Net Cat - This has been called the Swiss army program for

hackers. It performs many sniffing and cracking tasks.

This was really just some of the basics. But, if we know why

security is so important, we may remember to take the right

precautions. Hope your web surfing stays secure.

GENERAL INTEREST

Copy Only Changed Files
Durham Personal Computer Users Club

This screen shot is pretty self-explanatory. The purpose is

to check for, and copy, only those files that have changed,

based on a choice of date and/or time or by binary comparison.

Copying from one directory tree to another is possible, as is

appending and overwriting. ‘‘Copy to’’  folders and files may

be assigned a date appendage. For those who take lots of

photos, or those who must keep reliable back-ups of files

scattered all over the place, this is a real time saver and its a

free program. Go to  <http://copychangedfiles.com/>
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OPERATING SYSTEM NOTES & TIPS

Soluto Anti-Frustration Software
Improves Boot Time

 by Ira Wilsker

WEBSITES:

http://www.soluto.com

http://blog.soluto.com

http://www.soluto.com/About/Media-Kit

            In several past columns I have written about utilities

that can speed up the computer boot process.  As cluttered

as it was, my old XP machine could take up to five minutes to

boot; my newer Windows 7-64 machine boots in under two

minutes, considering the multilayered security that is installed

on it.  Traditionally, the ways of speeding the boot process on

a PC was to defrag the hard drive, and clean up the programs

in the startup that load when the computer is first turned on.

When someone tells me that his computer takes forever to

boot, my typical responses are ‘‘is your hard drive defragged’’

(defragmented), and ‘‘how many little icons do you have on

your task bar adjacent to your clock?’’.   There are several

excellent startup managers available (including Windows

‘msconfig’’ feature), both independent utilities and compo-

nents of utility suites, that can easily control what programs

load at boot.  Simply unchecking unwanted and unnecessary

programs at boot is an accepted way of improving boot time.

Likewise, there are several excellent defragmentation utilities

available, including the simple one built into Windows, that

can do a credible job; by defragging the hard drive, it does not

have to work as hard when reading files and data, thus

providing some improvement in load times.

While these two methods are well accepted and proven to

speed up the boot process, a new concept in utilities was

recently released that goes an extra step in controlling the boot

process using a software ‘‘genome’’ and community experi-

ences to determine what is loading in the computer at boot,

how long each item takes to load, displays what is required or

optional to load at boot, and gives the user control of what

loads and when it loads during the boot process.  Wanted, but

low priority items, can be set to load after the computer has

fully booted, and is sitting idle, thus not degrading the boot

process.  Unwanted items can be stopped from automatically

loading, but set to load upon demand.  The process may sound

complex, but it is very simple with the information provided by

this new utility, ‘‘Soluto Anti-Frustration Software (beta)’’.

Available as a free download from www.soluto.com, this

software is a ‘‘beta’’ or pre-release version, which by defini-

tion, is not a highly refined final ‘‘release’’ version.  My 18

month old ‘‘new’’ computer booted very quickly when new,

but now that I have a lot of security software and other utilities

loading at boot, it was taking between a minute and a half, and

two minutes to boot.  After I downloaded and installed Soluto,

and rebooted the computer such that Soluto could measure

and analyze my boot process, my first modification of my boot

process improved my boot time by almost 25%!  Subsequent

refinements of my boot process with Soluto, and input from

the ‘‘community’’ have helped me to shave off about another

10% of my boot time.

After being installed, Soluto monitors what loads at each

boot.  During the boot process, the bottom left corner of the

desktop turns up like the corner of a page and displays each

item as it is loading, while displaying the elapsed time to boot

the computer.  Information is gathered during the boot pro-

cess, and added to what has been gathered at previous boots,

to provide the data that is analyzed by the program.  The data

that is collected is anonymously added to the Soluto PC

Genome, where the community can input recommendations

that will assist the user in determining what can be controlled

at boot.  According to Soluto, ‘‘ This anonymous technical

data is gathered and sent to Soluto’s PC Genome, a one of a

kind knowledge base containing statistical insights about PC

software and hardware behavior, as well as remedies to

alleviate PC usage frustrations. By putting this information

into the light, the PC Genome will help consumers and vendors

alike.  Soluto employs another set of innovative algorithms to

determine which remedies will have a positive impact on each

Soluto user’s unique PC system. These remedies are then

shared with other relevant Soluto users.’’  Soluto has found

that by pausing when specific items load in the boot process,

and reconfiguring some of the applications, boot time and

overall behavior of the computer can improve dramatically.

Soluto can also determine those programs that degrade com-

puter performance, and provide the ‘‘frustrated’’ user with

possible solutions to reduce or eliminate the source of frus-

tration.

Soluto places a small icon on the task bar that looks

somewhat like a smiley-face, and opens displaying the Soluto

functions.  By opening Soluto anytime after the computer has

booted, the first screen called the ‘‘Boot Page’’ displays

‘‘Potentially Removable’’ items in an orange font, along with

the boot time and sequence for each.  By moving the cursor

over any of the ‘‘Potentially Removable’’ items, a brief de-

scription of the software is displayed (if it is in the Genome).

By moving over the ‘‘more’’ on the display, a recommendation

may be shown, as well as a pie chart of what other users of that

software have done.  The user is given the option to ‘‘Pause’’

or ‘‘Delay’’ the item in subsequent boots. ‘‘Pause’’ prevents

the item from being loaded at boot, but the program can still

be loaded upon demand; ‘‘Delay’’ postpones the selected

program from automatically loading until the computer is

otherwise idle, which means that it will not slow the initial boot

process.  Since Soluto (beta) has just been released, the

genome is still in its infancy, and does not yet contain a

comprehensive database of software.  The user can easily
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click on the pencil icon ‘‘edit’’ and open a Wiki which enables

the user to ‘‘fill in the blanks’’ about an item, which will then

be verified, and added to the Genome.  As more users complete

the Wiki, the Genome database will become more complete.  As

the Genome improves through this community input, all of the

users can benefit by the dissemination of the information.

            The grey section of the main screen ‘‘Boot Page’’ in

Soluto displays the ‘‘Required -annot be removed’’ items that

load at boot, in their boot sequence and with their boot time

displayed.  While most of the items shown are valid Windows

components, with an explanation of what each does along

with its boot time, some of the items are non-Microsoft files,

and lack detailed descriptions.  When I first used Soluto, the

components of my MagicJack VoIP service (internet based

telephone service) were listed as ‘‘Required’’, and could not

be paused or delayed; I opened the Wiki and explained what

they were, and then commented that I thought that these

particular components should be moved to the ‘‘Potentially

removable’’ section where their boot process could be better

managed.  As the Genome grows and improves, items like this

will be better sorted into the appropriate category.

The blue section on the ‘‘Boot Page’’ shows the items that

were ‘‘Paused’ or ‘‘Delayed’’ at boot, and how much time

wassaved by not loading those items.  Clicking on any blue

item gives the user the choice of changing the status to boot,

‘‘Pause’’ or ‘‘Delay’’, which will be implemented the next time

the computer is booted.

            An interesting choice on the Soluto icon is ‘‘My PC just

frustrated me’’, which opens the Soluto window, and analyzes

the running processes, and tries to determine which program

is causing the slowdown.  Any information found during the

‘‘frustration’’ analysis is anonymously added to the Genome

where it will be comingled with other data and potential

solutions may be determined.  If a solution to the ‘‘frustration’’

exists, it looks like it will be displayed to the user.  When I

clicked on the ‘‘Frustration’’ menu item, Soluto identified the

beta version of a new security product that I am testing as the

potential source of ‘‘frustration’’ but could not yet show any

remedy to my ‘‘frustration’’.

            While Soluto is still in the ‘‘beta’’ stage of develop-

ment, I found it a very useful and worthwhile utility to improve

PC performance, particularly in the boot process, and for

resolving potential ‘‘frustrations’’.  Users should give Soluto

Anti-Frustration Software a try.  In my limited experience with

it, I would give it my recommendation, as well as a rating of

‘‘two thumbs up’’.

HARDWARE NOTES & TIPS

Security - Recycling & Inheriting PCs
by Stephen J. Bigelow

Reprinted with permission from Smart Computing

<www.SmartComputing.com/groups>

Personal computers rarely have a single owner. A PC is

often handed down to family members as newer equipment

enters the household. Similarly, used equipment may be

donated to charitable concerns, or corporations may sell older

systems as new desktops displace their existing platforms.

But the charity and goodwill associated with used equipment

carries potential security risks. Systems infected with viruses

or other malware, unpatched vulnerabilities, and sensitive

data remaining on the system are just a few problems that can

compromise the security of a used system. Whether you’re

inheriting a used system or passing your old PC to another

user, this article highlights some ways to stay secure.

Giving Away A Computer

The brand-new shiny PC you ordered finally arrived, and

you’re thinking about what to do with your existing system.

Before breaking down that old system and boxing it in a corner

or giving it away to a local organization, it’s important to

consider all of the valuable or sensitive data that might be on

it.

Before donating or giving away your old computer, use a file

shredding utility to ensure that any data deleted from your PC

is unrecoverable.

First, if you have applications on your existing system that

you plan to run on the new system, such as Intuit Quicken or

Microsoft Office, be sure to make a backup copy of your data

files from the old system. It’s a simple matter to copy files onto

a USB flash drive or external hard drive. Take the time to decide

which applications need to be installed on the new system (if

they’re not on the new system already). Locate the installation

media for those applications and pay particular attention to

the license numbers or registration keys; you’ll need these to

activate the applications once they’re installed on the new PC.

The product key is usually printed on the installation disc or

included in the software box or with the users manual.

At this point, you can uninstall the applications from the old

PC and make sure that any data files associated with that

application are deleted. This may seem like a bit of work, but

most software licenses only cover installation on one ma-

chine, so it may be illegal to install the software on your new

system without removing it from the old system. Install the

applications on the new PC and copy over the data files at your

leisure.

Next, you don’t need the new owner of your used system

seeing where you’ve been browsing or checking into your
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favorite bookmarks, so take the time to delete all of the

temporary files and folders for your browser. Don’t forget to

empty the Recycle Bin because any sensitive files left in the

Recycle Bin can be opened or restored.

Once you’ve removed applications, deleted data, cleared

temporary content, and emptied the Recycle Bin, use a file

shredding tool such as File Shredder (free;

www.fileshredder.org) to thoroughly overwrite all of the hard

drive space that you just cleared. Use a high-security algo-

rithm to prevent any chance of the next user recovering any

sensitive data with forensic data recovery tools. You should

then be able to pass that old system to its new owner with a

feeling of security.

Accepting A Used Computer

If you inherited a used computer, use anti-malware software

to perform a complete system scan before installing sensitive

applications and data.

It’s great to get another PC. But even if the system is coming

from a friend or relative, you still don’t know where that system

has been. Before installing new applications or using the

system at all, start an anti-malware program (if there isn’t one

already installed), update the anti-malware signatures to their

latest version, and then perform a full scan of every drive on

the system. It doesn’t matter how long it takes. If there is any

malware on the system, it’s best to find and eradicate it before

you trust sensitive data on the computer. Products such as

Malwarebytes Anti-Malware (www.malwarebytes.org) can

do the job free. If you find one or more infections, be sure to

remove the infected items and repeat the scan until the system

checks completely clean.

Remember that the system should have a full security suite

installed, particularly if you intend to run the system with a full-

time broadband Internet connection. There are numerous

vendors, each providing well-tested products, but the secu-

rity suite should include a firewall, anti-malware, and intrusion

detection/prevention.

Once you confirm that the hand-me-down system is malware-

free, run Windows Update (http://

www.update.microsoft.com). This will examine the operating

system and other installed Microsoft applications, such as

Office, and identify any updates, service packs, security

patches, and other content that will plug potential exploits and

bring the system to a current security posture.

Your last step as the recipient of a used computer should be

to perform a complete backup of the system to a DVD or

external hard drive. Although the PC probably shipped with

a system image disc when it was new, the previous owner may

not have passed on the original media to youif the hard drive

quits, you won’t be able to restore the system. Performing a

complete system backup to separate media is your best

insurance against any problems that may arise later. Now, you

can go ahead and use the inherited system with confidence.

Should You  Defrag A Flash Drive?

You should never defrag a flash drive. Does that surprise

you? First, a little about hard drives. The files you have stored

on your hard drive are usually saved in several little pieces,

often in groups of 512 bytes. Now, those chunks of data are

usually never placed next to each other or even remotely close

to each other. Therefore, your files are generally spread out all

over your hard drive, which is why defragging is so important.

Defragging simply helps speed up your system when you

need to open a certain file.

That’s why it’s so vital that you defrag on a regular basis

(at lease once a month.) The whole defrag process is done

through a read/write head that rearranges your files and places

them back together for you. so your computer doesn’t have

to work as hard to find what you’re looking for. On the other

hand, flash drives do not have a read/write head, so if you were

to defrag one, you wouldn’t get any extra performance ben-

efits from it whatsoever. Basically, without a read/write head,

flash drives don’t have to work any harder to find your files.

Your files can be laid out in any order, and your flash drive will

be will still be just as fast.

Another reason why you should never defrag a flash drive

is because flash memory wears out over time. Basically, the

more you write (saving files, etc.) to your flash drive, the

shorter its lifespan will be. And since defragging is a huge

write process, every time you do it, you’re adding thousands

of extra writes to your device that just aren’t necessary. So, if

you’ve been continuously defragging your flash drives, you

should stop. If you want your flash drive to last you a long

while, simply stop the defrags. You won’t get any benefit from

it and you’ll just end up with a broken down flash drive for no

reason at all. Go and defrag your hard drive instead!

Lurking Dangers of Larger Hard Drives
by Diane Fahlbusch, June 2010 The ICON Graphic, ICON

User Group, Long Island, NY

We all know that one of the most essential components of

our computer is the hard drive. Its is the home of your

operating system, firmware, applications and those precious

files you have collected over time. Faster processors, more

RAM are useless if there is nothing to pass through them. Not

so long ago, people were dancing around because they could

get a 20GB drive on a notebook. Now, we scoff at a puny 160

GB drive on the same type of hardware. But is a larger hard

drive better?

A larger hard drive will mean that you can have multiple

operating systems and/or virtual machines. You have the

space! Its a great way to explore new options. Just remember

to back EVERYTHING up properly before you experiment! It

also helps make intense graphic work (photo editing, video

rendering, CAD design, etc) possible.

Now you can also save LOTS of files, and large ones! But

when was the last time you opened some of these files? Do you



TOGGLE  August  2010  Page 10

really need them, or are you just saving some of them because

you can? With that 20 GB hard drive you did a regular cleaning

because there wasn’t enough space and you probably just got

rid of some of those files. The ones you needed but rarely used

were removed from the hard drive to some form of external

storage. Here is where a larger drive is useful. (Then again, you

can always build a RAID.) That ample storage can create a

Scarlet OHara syndrome: I’ll back up tomorrow. After all,

tomorrow is another day!

You can load up on programs! But remember that every time

you install an application on Windows machines you are

making scattered changes to the registry. These may not be

easy to remove. Sometimes they run something in the back-

ground, eating precious resources. Some set themselves to

run on boot up, giving you time to watch the entire Thanks-

giving Day Parade before your computer starts. Many of these

applications also want to install helpful toolbars that take up

space, add more registry entries and may be connecting or

reporting to Internet sites you dont really want to go to. Some

take over and set themselves as the default program when

certain files are opened. You may have to go back and take

control over your computer, instead of getting to what you

wanted to do in the first place. This is fine, if you really believe

that you will get use out of those programs. Consider its

practicality, effectiveness, and ease of use for you before

installing it.

So you have done some file and soul searching, and you

want everything you have, and more. But beware of the lurking

danger of that large drive  the tendency NOT to back up your

files. That ample storage capacity never forces you to make

room for the new. Also, the greater the collection of informa-

tion stored makes your anti-nasty-ware (my personal catch-all

phrase for spyware, adware, malware) scans take much longer

to run. Large files are more readily fragmented because the

computer can sprawl them out. If you are regimented and do

backups (Bravo!), youll need storage capacity of matching or

larger size. If that large drive gives up the ghost, the greater the

replacement cost will be. And remember, all that information

has to be transferred to another drive, provided you backed it

up. Consider all the options before deciding what is right for

you.

Troubleshoot Your Digital Camera

If you’ve connected your camera to your computer, but your

camera can’t transfer the photos to the PC, first doublecheck

the transfer procedures for your camera. Some cameras require

only that you press the power button. Other cameras also

require that you turn a mode dial to a USB Transfer mode.

Sometimes data transfer problems occur because your camera’s

driver (software that tells your PC how to communicate with

an external device) has become corrupted. You have a couple

of options. You may download the most recent driver for your

camera from the manufacturer’s Web site, install it, restart your

computer, and then try to transfer photos again.

Another option is to bypass the driver problem by using a

card reader to transfer photos to your PC. Make sure that you

buy a card reader that supports the type of memory card that

your camera uses. When you use a card reader, you’re less

likely to encounter the device conflicts that often occur when

a camera’s driver conflicts with another device’s driver. (This

is especially likely to happen if there’s more than one digital

camera in your home.)

Reprinted with permission from Smart Computing. Visit

http://www.smartcomputing.com/groups to learn what

Smart Computing can do for you and your user group!

Who Invented the ‘‘CD’’?
Submitted by Consuelo Langholz

July 2010 Connections, Verde Valley Computer Club

What an amazing cavalcade of inventions we have seen in

our lifetime. We have no sooner ceased to marvel at - or grasp

one form of technological advance when the next innovation

appears. Equally amazing has been the steady reduction of

prices charged for these inventions in relation to the dispos-

able income of the ordinary working person. Remember those

first vinyl LP records we had to save for weeks to buy. James

T. Russell who had displayed a flair for invention from the age

of six when he made himself a remote-control battleship,

earned a BA in Physics in 1953 at age 22 and joined GE where

he was involved in some ground-breaking instrumental

projects. By 1965 he was a senior scientist at the Battelle

Memorial Institute Laboratory in Richland, Washington and

had his sights set on audio research and improvements.

Russell wanted to find a way to improve the sound quality

and prevent the wear and tear caused by the physical contact

of the needle in the groove of his records. He worked toward

an idea to use light to achieve this and used his knowledge

of digital data recording as employed in punch card or

magnetic tape devices. He therefore aimed to make a device

that could read the binary code 0 and 1 with dark and light. He

realised that if he could make the code compact enough he

could store large quantities of music and huge amounts of

data. The Massachusetts Institute of Technology writes;

Russell succeeded in inventing the first digital-to-optical

recording and playback system (patented in 1970). He had

found a way to record onto a photosensitive platter in tiny

‘‘bits’’ of light and dark, each one micron in diameter; a laser

read the binary patterns, and a computer converted the data

into an electronic signal -- which it was then comparatively

simple to convert into an audible or visible transmission.

Through the 1970s, Russell continued to refine the CD-

ROM, adapting it to any form of data. By 1985, Russell had

earned 26 patents for CD-ROM technology. He then founded

his own consulting firm, where he has continued to create and

patent improvements in optical storage systems, along with

bar code scanners, liquid crystal shutters, and other industrial

optical instruments.

Compliments of the ASCA Australia Senior Computer

Assoc.
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Tacoma Open Group for Microcomputers (TOG)

New Member Application/Existing Member Change of Address Form

For Tacoma Open Group annual membership, send form  (if needed) & $25 to Bob Henkel., 10613  25th Avenue E., Tacoma, WA 98445.

Make checks payable to TOG

Please print or type.                              Date:___________________________           Sponsored by:_______________________

Member's Name:______________________________________________________________________________________________________

Address: ____________________________________________________________________________________________________________

City:___________________________________ State:___________ Zipcode:____________Plus Four _______  Country: __________________

Home Phone: ( ____ ) ________________  Work phone: ( ____ ) ____________________ E-Mail Address ______________________________

Help Lines
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TACOMA MEETING

When: Mon  9 Aug 2010 -7:00 PM
Where: SE Tacoma Community Centre

1614 99th Street E.
Tacoma, Washington

From I-5 take Exit 127 (Hwy 512) to
Portland Ave., north on Portland to 99th,
left over tracks. Building is on south side.

Future Dates: 2nd Monday of Month

TOG BOARD MEMBERS

President Carl Tenning (206) 824-3843

 & S. King County Rep c.10ing@toggle.org

      web page: http://carlten.tripod.com/index.html

VP/Prog Chair Vacant

Sec/Treas Bob Henkel     (253) 537-6732

    bobh@nventure.com

Disk Library Tom Stepanek (253) 922-7939

tomstep7@msn.com

Newsletter Editor Bob Thomson (253) 752-5582

     rjthomson@comcast.net

Kitsap County Rep   Ray Mills (360) 692-7568

e-mail: r.mills@rm-a.com

       web page: http://www.rm-a.com

TOG Web Site: http://www.toggle.org

======================================
Deadline:  15th  of  this  month  to   appear
in next months’ issue, if room
======================================

PROGRAMS

This Month’s Meeting

This will be a regular monthly meet-

ing. Meeting discussions are always

interesting and the ever-popular Q&A

(Question & Answer) period is sure to

pique your interest, come up to your

expectations and tickle your fancy.

Come and share your own experiences,

problems and discoveries.

Program Presentation

No program has been announced at

press time. But as usual members will

bring up problems and discoveries that

they have made while using their com-

puters and are sure to lead to interest-

ing discussions. Come and bring your

questions.

Corporate Sponsors:

Raymond Mills & Associates
www.rm-a.com

How To get To The Meeting

For those readers still unfamiliar with

how to find our meeting place we have

reproduced the map showing its rela-

tionship in Tacoma to Portland Ave S.

and the 512 Freeway. The 512 Freeway

can be entered from I-5 in Tacoma on

the west or from Hwy 167 in Puyallup on

the east. Proceed to Portland off-ramp

and turn north to 99th Street. Some

folks in the middle of Tacoma may pre-

fer to take Portland southbound to 99th.

At 99th turn west over the tracks and

there you are!

Tacoma OPEN Group for Micros

1808 Lenore Drive

Tacoma, WA  98406-1920

Change Service Requested


